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E-mail is an integral part of modern law practice. You can take control of your e
mail communications and practice more efficiently by changing how you think about
and handle your e-mail. It has never been more important to manage your inbox.

Ever since the first e-mail was sent in late 1971, the number of messages being
sent around the world has increased, and is now estimated at 2 million per second. 1 It
has changed how we communicate with each other, both in speed, style, and
expectations. Lawyers face not only the deluge of messages but the implications raised
by a faster, less formal communication medium. The practical challenges of time
management and efficiency compete for importance with the ethical and professional
issues e-mail raises.

The lawyer-client relationship may change when using e-mail. A court relied on
e-mails to establish personal jurisdiction in a case where the defendant had never
physically entered a state. 2 Another court recently found that a settlement between
two parties, completed entirely bye-mail, was enforceable and not just a prelude to a
more formal agreement.3

Lawyers who rely on e-mail communications may need to utilize a higher degree
of care than they might expect. As your e-mail program becomes more powerful, it can
"help" you into troublesome and inadvertent communications and disclosures.4

How do you take control of this demanding technology? Let's take a look at a
few practical tips:

1. Choose an e-mail application that will best suit your practice needs;

1 E-mail Inventor: I Did Not Foresee Spam, Times Online, March 11, 2008 <
http://technology.timesonline.co.uk/tol/news/tech and web/article3525110.ece > Stats Canada found
95.4% enterprise use of e-mail in Canadian professional services companies in 2006. 2008 Statistics
Canada Market Research Handbook. <http://www.statcan.ca/english/freepub/63-224-XIE/63-224
XIE2007000. pdf>.

2 Fischbarg v. Doucet, 2007 N.Y. Slip Op. 09962 (N.Y. 12/20/2007)

3 Basis Tech. Corp. v. Amazon.com, 878 N.E.2d 952 (Mass. Ct. App. 2008).

4 Misdirected E-mail Set the Stage for Clear Channel Suits,ABAJournal.com, March 27, 2008;
High-Profile Skadden Litigator Goofs, Sends Private E-mail toReporters.ABAJournal.com. February 21,
2008; NYT Reporter Says Lawyer's E-mail Goof Nota BigBlunder,ABAJournal.com, February 11, 2008;
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2. Cut down on e-mail, by filtering out spam and less important messages;

3. Find alternatives to e-mail, so you can stay on top of information without the
clutter;

4. Manage your e-mail, so that it remains a powerful communication tool for your
practice.

E-mail Application Selection

Before you start to manage your e-mail, you must know how you are going to
access it. You have two alternatives: a software application that you install on your
computer or an online service that you access through your Web browser. Most
lawyers will use the e-mail software provided by their law firm. This software is
installed on their work computer and configured to work with the firm's systems. E
mail software like Microsoft Outlook or Novell's Groupwise have the benefit of powerful
organizational tools either built-in or available through add-on programs. These tools
can greatly enhance your ability to manage your e-mail, but your access may be more
limited because it relies on having access to the e-mail software.

The past few years have seen an explosion in online e-mail options. These are
alternatives to downloading and storing your e-mail on a single computer in your office.
A free e-mail account from well-known companies like Google, Yahoo!, and Microsoft
can make your practice more flexible.s Check your e-maii from your office, home, local
law library, or anywhere with an Internet connection. If you have been relying on an e
mail account from your Internet Service Provider (ISP), you will find that the free online
accounts often offer more storage space. 6 By using an online account, you can also
rely on their systems for backup. This can be a significant benefit to sole and small firm
lawyers who may not have technology staff to support their systems.

On the other hand, online e-mail is only as good as your Internet connection. As
with any tool that is offered as "software as a service" (SaaS), if you do not have access
to their service, then you can't use their software.? When you use a program like
Microsoft Outlook, you can download and store a copy of your mail on your hard drive.
When you reconnect to the Internet or your firm network, you can send any e-mail that
you have created and receive any that has been waiting for you.

5 GoogleMaii <http://mail.qoogle.com>; Yahoo! Mail <http://mail.yahoo.com>; Microsoft
Windows Live / Hotmail (http://www.live.com)

6 As of March 31, 2008, Rogers and Sympatico (Bell Canada) each offer 2 GB of mail storage as
part of their service. GoogleMail offers 6 GB and Yahoo! Mail offers unlimited storage.

7 For more on SaaS: <http://en.wikipedia.org/wiki/Software as a Service>. Similar concepts
have been promoted alternatively as "thin computing" or being provided by "application service
providers" (ASP).
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If you have the option to choose your e-mail program, you should balance your
need to have flexible access with greater power and control, the cost of the product,
and the maintenance processes to make sure your e-mail is backed up and accessible.
You can also find a point in between: use a stand-alone e-mail program, like
Microsoft's Outlook Express or Outlook, or Mozilla's Thunderbird, installed on your
computer.s Use that software to access an online e-mail account, like the one provided
by your ISP. This eliminates the need for technical expertise in running the e-mail
server, but gives you the flexibility to have access to your e-mail when you need it.

Lawyers have a particular challenge in selecting an e-mail application. If you are
using a practice management program, like LexisNexis' TimeMatters or Gavel & Gown's
Amicus Attorney, you may be able to integrate your e-mail program into your practice
technology.9

Microsoft Outlook Essentials

It's worth focusing on Microsoft Outlook, which has a significant presence in
businesses, as well as the legal profession. 1o The latest versions of Outlook (2003 and
later) have quite a few tools built in to make managing e-mail easier. You can organize
communication relating to a specific client and matter by creating folders that mimic the
firm's paper file structure. Other communications with vendors, staff, volunteer
organizations, etc., can also be sorted as if it was incoming paper. The more uniform
your filing model is for paper, e-mail, and electronic documents, the easier it will be
migrating from one to the other. In addition, there are some specific tools in Outlook
that enable you to better organize your e-mail.

Microsoft Outlook 2003 has several features that help users organize messages,
for quick retrieval and management. These tools make organizing e-mail a snap by
helping sort through messages, remember which e-mail message requires follow-up,
and group similar items without archiving messages manually.

Search Folders
Search Folders are virtual folders that contain views of all e-mail items matching

specific search criteria. Search Folders contain the results of previously defined search

8 Microsoft Outlook can be configured to use a Microsoft Exchange server in larger law
firMicrosoftbut it can also be used to download e-mail using POP (Post Office Protocol). Mozilla's
Thunderbird <http://www.mozilla.com> is a free POP e-mail program.

9 Can't We All Just Get Along? Integration in Case Management Systems, Sheryl Cramer,
LLRX.com, May 1, 2002 < http://www.llrx.com/columns/kccase.htm>

10 For example, the International Legal Technology Association's 2007 annual survey indicated
respondents used that over 80% used Microsoft Exchange Server for e-mail.
<http:jjwww.iltanet.orgjcommunicationsjpub_detail.aspx?nvID=OOO000011205&h4ID=000001014405>.
Slipstick is an excellent site for Outlook productivity tips and information on software updates
<http://www.slipstick.com>.
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queries, but all e-mail items remain in their original Outlook folder. With Search
Folders, you can easily group and browse through all items relating to a subject,
person, task, or other criteria, without physically moving messages or folders.

Three Search Folders are created for users by default:

• Unread Mail. All unread e-mail items appear in the Unread
Mail Search Folder.

• For Follow Up. Any e-mail message that includes a flag
appears in the "For Follow Up" Search Folder.

• Large Mail. E-mail items that are larger than 100 kilobytes
(KB) appear in the Large Mail Search Folder.

These three default Search Folders can be modified or
deleted. Each user will find Search folders for each folder
grouping, including Exchange folders, personal folders, and
departmental folders.

Use Search Folders to group and browse through all items that relate to a
subject. You can create a new Search Folder by:

1. In Mail, on the File menu, point to New, and then click Search Folder.

2. Use a predefined Search Folder or click Create a custom Search Foider.

Contoso P
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Quick Flags
Don't lose track of an e-mail that

requires follow-up action. Using quick flags ~FmOV_i"••i~iii"__.iiii.ji••!jiiiiQ~c~o:nt:os:o:pr~o
~. ~ Atrangod By, Flog IRod C>"1 top " "

to mark a message, meeting request, or ~lnboX ;i,. Annette Hil
Cit lliood M" B Red A.9

contact adds a flag icon to the item. The ~ForFoliowUp[5]
IQ Sent lterns

six colored message flags highlight the type
of action required, based on urgency.

When users add a message flag, the
background color of the Flag Status column
changes color, making it easy for users to
find items in the message list while
scrolling. Items to which a message flag is
added automatically appear in the For
Follow Up Search Folder.

Messages can also be flagged when you are reading the e-mail or from the
desktop application.

Any message, meeting request, or contact that has been flagged is visible in the
"For Follow Up" Search Folder (see above for more on Search folders). Items are
grouped by the type of follow-up action they require, which is indicated by the color of
the message flag. Use this folder to group and browse items that are intended for
follow-up action or further reference.
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Intelligent Grouping
Organizing messages is easy with Outlook 2003. The Multi-line view puts the

sender's name in dark text in the upper-left corner, making it easy to scan down the list
for important names. Secondary information is rendered in lighter shades of text to
draw the eye towards the more important information.

The Smart Dates feature uses space more efficiently by changing the date format
on the fly, based on how long ago the message was received. For example, an e-mail
message that was received today will only display a time: 3:40 p.m. Messages that

!iO 1_ &etioos ~ were received during the current week display
arr..-.oeBy • ~ I<ata a day of the week and time: Wed 1:24 a.m.

~ Na~lgatlonPana Alt+Fl !;;onve"atlon For e-mail that was received many months
Readino Pane Erom

11-='='1,..1 Auto!,!ev;ew 10 ago, the exact time is less important, so
E~and/ColapseGroups. ~er Outlook 2003 displays only the date:
Reminders W!ndoo Size

Rafr..r, FS Subiect 1/12/2003. This makes it easier for you to
T~e sort, find, file, and manage e-mail quickly and
Flag

attachments efficiently.
fl O,,1s

Plan E·mail AccQ.unt

e Chris Importance The new e-mail view automatically
PL¥1 Cat~go"es applies intelligent groupings to help sort

1~~=r.l~_~I~G~'oy~w°ls~r~~ :::'~roups messages. For example, when messages are
:. S!lowV;ews!nNav;getionPene arranged by date received, Outlook 2003 splits
H.ov Curr.nt~lew them into simple groups ("Today,"

"Yesterday," "Last Week," "Last Month," and so on). When messages are arranged by
size, Outlook 2003 again divides messages into user-friendly groups ("Large," "Small,"
"Very Large," and so on). These groups make it easier to scan through a list of several
messages.

You can treat these groups as objects, choosing to move, delete, copy, forward,
or perform other actions on all items in the group at one time. For example, messages
can be grouped by date, and then you can drag all of the messages from "Last Month"
to another folder, filing them away with one click.

Apply intelligent grouping by:

1. On the View menu, point to Arrange By, and then select the appropriate
arrangement.

2. To customize the arrangement that has been applied, on the View menu, point
to Arrange By, click Custom, and then select the appropriate options.

3. To remove intelligent grouping simply uncheck the "Show in Groups" option.

Arrange by Conversation

You can also group messages by subject or "thread." The sorting order of items
in the "threads" is based on who replied to whom, and items in a thread are sorted by
date. When a new message is received, the entire conversation to which it pertains
moves to the top of the message list. By default, only unread and flagged messages
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2. To customize the arrangement, on the View
menu, point to Arrange By, click Custom, and
then select the appropriate options.

appear. Users can see all messages in the conversation by clicking the arrow that
appears next to the conversation heading. Messages are
indented to show who replied to whom and when the
reply was sent.

ZOO3·2000i l":\e-etfljl~

How to arrange by conversation: '---'=~=--=[r="~=::::'::""ing I='/8=/200=3-,-V
t3l W1'lelan, rMvid

1. On the View menu, point to Arrange By, and
then click Conversation.

Simplified Rules Wizard Dialog
Outlook 2003 has made applying rules to new

message and folders easier than ever before. The
"ready-made" rules help users quickly apply rules to new messages, while detailed rules
customization is still available. Users can apply rules to new e-mails individually, or can
choose to write rules using the rules wizard to process mail.

WNW xl The new, simplified Rules Wizard provides templates
~:::~:;,~;:':*'~ or the option to create your own rules.
51",,11$*t.~

2. Select New Rule

3. Select a template to apply to incoming messages

To apply a rule to a specific message, right-click on
the message and select Create Rule from the drop down
menu.

E>tampI~: MoYe mal from my manager to my High Importance rolder
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:eJ Mo'we~S4oOts...thspedi(-o,;lrltheMojec:tloo'oIdef I
-8 MiMI mes~ssent to" distribution ht to. folder

Xo.lII.leconversatiQn
l" I'\IQ IIWlSS<lQM from someone l"I;h 0 color~ f1eq

51• ., Up I0 ,Q.~~."", _., __ ""., ..,.., ,,,,,,.,,,.,,,,,_ _, .
~I OlfPIyrMIf,omsomeonelntheNewnemAlert~

'.9 "'rt.""-J'\d~loetIWlWQMfrcn~

MSel'ldart'*rtto'*llllCOledeYlt'oof\erlIQeC~""9MfT'Ol'fI __

AoPY w. lUI dl. tN IllrIH9I' .......
~ .... j¥!Ip,Jjtlt,MTIZ
moveltou'lll~fdder

Microsoft Outlook Addons and Plug-ins
You can extend Outlook with additions and plug-ins, many of which seem

redundant if the program is used properly. However, there are a number that offer
some interesting options for attorneys:

QuickFile 4 Outlook - Lawyer's edition

http://www.outlook4Iawyers.com/

The add-on QuickFile 4 Outlook - Lawyer's edition offers the ability to batch print
e-mails with headers that reflect case or client matter numbers or file name references,
a function that may be less useful in the "less" paper office. If the Outlook e-mail
folders have been set up in the same way that the firm's paper folders are arranged this
would make it easy to find and file printed e-mail. QuickFile will also file incoming e
mail with a single click, as well as automatically filing sent mail in the proper folder.
Probably the most interesting function in QuickFile is it's ability to convert entire e-mail
folders to HTML or Microsoft Word (with TOe and hyperlinks and attachments). For a
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closed matter and for archiving purposes this functionality rivals the functionality of
Adobe Acrobat's ability to save Microsoft Outlook folders as PDF documents. If the
other functionality seems intriguing, as well as the price ($99US), this may be a plug in
to check out.

Anagram

http://www.iambic.com/select/?itemid=97

Many attorneys may not take the time to enter in information from the signature
line of an e-mail into Microsoft Outlook contacts. However, Microsoft Outlook 2007
contacts can provide the functionality of a customer relationship management program.
So why not use it? For $30US the Outlook add-in Anagram intuitively parse contact
information from e-mail signature blocks, as well as Web sites and desktop applications,
and enter it into Microsoft Outlook as a contact, a calendar appointment, a note, or
task. Simply copy a signature block, hit a user-defined shortcut, et voila - the
information is reformatted and added to Outlooks contacts.

GTD Plug-in for Microsoft Outlook

http://gtdsupport.netcentrics.com/buy/indexd.php

There are many fans of David Allen's Getting [it] Done, and the GTD Plug in for
Microsoft Outlook is a big hit. Allen's e-mail management system is fairly simple - deal
with each piece of e-mail as it comes in, by either replying, deleting or filing it, with the
goai of having an empty inbox at the end of every day. This piug-in is designed to help
users employ that methodology in practice.

Xobni

http://www.xobni.com/

The latest buzz is the beta Microsoft Outlook plug-in Xobni. This add-on helps
harness the power of social networking from within Microsoft Outlook. According to
their Web site, "[w]hen a new e-mail arrives, the sender's full communication history
appears in the Xobni sidebar, including past conversations, attachments and contact
details. Xobni also includes a blazing fast e-mail search tooL" While Microsoft Outlook
2007 has come a long way from Microsoft Outlook 2003, this free (for now) plug-in
does seem appealing. The program is invite only for now, so sign up and wait for the
invitation.

Defend Your Border!

Your network border, that is. The first goal to e-mail management is to make
sure you are using tools that reduce the number of bad e-mails before they get to you.
These are the spam and threat e-mails that proliferate the Web. As benign as the
Cialis® e-mails may seem, you still have to delete them if they make it to your inbox.
Using e-mail filters to automatically delete these messages is difficult because they
change so often that your filters can't always keep up. More dangerous are the
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phishing and threat-laden e-mails that are trying to get you to provide personal
information, or to leave software on your computer in the form of a virus, worm, or
spyware. ll

A filter at your e-mail server can provide the first level of protection. Online e
mail systems will handle this function for you, eliminating the message before it even
reaches your inbox. Even when services like Microsoft's Hotmail offer a junk folder, it
has already intercepted and eliminated known spam. There are free and paid services
that offer lists of Internet addresses that are sources of spam; when you subscribe,
your e-mail server looks at the lists and blocks any matching sources. 12 Your law firm
e-mail server can also contains its own list, so that you can block e-mail not based on
content but on unreliable sources.

The next check is for content and this is often left to your e-mail program.
Google's GMaii offers a spam folder into which it places e-mails with questionable
content that come from reliable sources. Your e-mail software will offer a similar
feature. There are services, like MessageLabs or Postini that handle this before the e
mail reaches your e-mail application but they are not necessarily better at capturing the
e-mail and you have to go and visit their site to release any held messages.13

The final check happens as you open the e-mail. Your anti-virus software should
be enabled to check for viruses attached to the e-mail. They may be in attachment files
or they may be in the e-mail itself. Even if your anti-virus program does not find a virus
or other threat, you should still be cautious in opening attachments. Many recent e
mail threats use a tactic that causes the attack to replicate itself by sending a file to
everyone in your e-mail address list. If someone you know has opened an e-mail with
this sort of threat, it may appear to come from them even though they may not have
intended to send it to yoU. 14

11 Spam is usually a message with annoying content. A "phishing" e-mail can resemble spam but
it is fishing for information. It usually asks you to click on a link to do something: comply with a bank
account change, notify Canada Revenue of an address change, etc. When you click on the link, you are
taken to a Web site that looks like your bank or credit card company's site, but is really hosted
somewhere else. But the information you submit - passwords, dates of birth, etc. - are intercepted by
the scam artists behind the e-mail message. Spyware is when an actual piece of software is downloaded
from a Web site and placed on your computer. It can "spy" on your activity, looking for information that
resembles a password or date of birth. When it captures it, the spyware application then sends the
information out to a remote computer.

12 One method of blocking is to use Domain Name Server (DNS) blacklists <
http://en.wikipedia.org/wiki/DNSBL> .

13 MessageLabs E-mail Anti-spam <http://www.messagelabs.com/small_business>; Google's
Postini: <http://www.postini.com>. Postini offers three subscription levels, but is also used on all Google
GMaii accounts.

14 These threats are often called worms, as opposed to viruses. A virus often attempts to attack
your computer. A worm is primarily concerned about replicating itself and causes its mayhem by
generating massive amounts of e-mail.
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E-mail is Dead, Long Live E-mail

Now that you have controlled your e-mail environment, it is time to find ways to
cut back your e-mail traffic to make it easier to manage. Current awareness is an
important part of staying proficient in your practice but it can also contribute to e-mail
overload. Each case law alert, newspaper update, or CLE announcement you receive as
an e-mail is another document that needs to be viewed and managed: save it, delete
it, read it later?

Really Simple Syndication

A technology called Really Simple Syndication, or RSS, can alleviate some of this
e-mail traffic.!5 These are files that are automatically generated by Web sites,
containing links to information on the site that changes frequently. The file is often
referred to as a news feed. Common sites that use RSS include major news sources
like the Globe and Mail but just as often come from informal sources, like blogs.16

Resource sites like CanLII offers RSS feeds for court opinions, updating each time a
new opinion from a court is added to the site. For e-mail newsletters that aren't offered
as feeds, you can use a free RSS reader like Bloglines for ..e-mail subscriptions": create
an e-mail address through the service and use it for subscribing to e-mail news.!? Then
read all the messages in Bloglines' web-based interface.

T" ~et Starte~ W ifh DC::C::v \.:J u ...... ''''''''

You will need a "feed reader" or "news aggregator". There are two ways to
obtain an RSS reader: download a program to your computer or access a Web-based
application. The advantage of a Web-based RSS reader is that you will be able to
access your content from any computer. Some services are beginning to offer mobile
RSS delivery as well so that you could receive updates on your PDA or cell phone.18

15 For more on RSS feeds, listen to the Law Technology Now podcast from December 2007:
Exploiting RSS' Potential (MP3 audio file) <http://preview.tinyurl.com/63xzh4> or a related article, S!Qy
Informed: It's Really Rather Simple, Law Technology News, December 2007
<http://preview.tinyurl.com/6bhd7q>.

16 Mainstream media: The Globe and Mail <http://www.theglobeandmail.com/rss/> has a Law
page, as well as the Report on Business; Toronto Star
<http://www.thestar.com/generic/article/111417>; National Post <http://www.nationalpost.com/rss/>
and which includes the Financial Post Legal Post. Legal news media: Lawyers Weekly
<http://www.lexisnexis.ca/updates/>, Law Times News <http://www.lawtimesnews.com/>, Canadian
Bar Association News <http://feedsJeedburner.com/cba> . Practice resources: Canadian Bar Association
PracticeLink <http://feedsJeedburner.com/CBAPracticeLink>, Canadian Legal Publishing Updates by
Stem Legal <http://www.legalpubs.ca/>.

17 Bloglines E-mail <http://www.bloglines.com/help/faq#WhyEmail>.

18 Blackberry, Palm, and Windows Mobile users can read and download RSS with Mobipocket
eBook Reader <http://www.mobipocket.com> (free), Newsgator Go!
<http://www.newsgator.com/Individuals/NewsGatorGo/> (free),
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Popular downloaded readers include Newsgator's Feed Demon for PCs or NetNewsWire
for Mac users, as well as Microsoft Outlook 2007 with a built-in reader. Web-based
readers include Google Reader and Bloglines, as well as iGoogle, My Yahoo!, and
Netvibes that offer a personalized start page to track RSS feeds, as well as to use other
information widgets. 19

Looking for RSS content
Web sites providing RSS feeds want you to subscribe to them. They will often

link to their RSS content by using one of the following buttons:

~-~~-----~--
~ ~.oA1I4frrrlo:t. • • d

mI!or~or

You will see these logos on the Web page itself or in your Web browser.
Microsoft Internet Explorer 7 and 8 users will have a grey RSS button on their toolbar.
When you visit a site with an RSS feed on it, the button will turn orange and you can
immediately view the RSS feed. Mozilla Firefox users will
see the orange button appear in the location bard, where J 0~w_"_~,,,

the Web site's address appears. Click on the orange 1---=========1
button to see the available RSS feeds at that site.

Adding RSS Feeds to Your Reader
When you find content that you want to add to your reader you will need to

complete a few simple steps to add the Web site's link so that your reader wiil aiert you
when new content is available.

-_ .. -- _.- .... - ..... _.._.. -. ----- - Use this Pipe

1~"","----=Goo=&Ie~) .' Results by En-,sil or Phone More options...

lily

items

I independence

If you use Google, Yahoo!, Bloglines, or Newsgator, you may see logos specific
to those services displayed on
Web sites. Click on the icon that
matches your reader application
to add the content. Bloglines also
offers a way to watch pages or
blogs that do not have RSS feeds.
You can add a "Sub with
Bloglines" to the Favorites in your
browser. When you are at a site
that you want to track, you can
click on the "Sub with Bloglines"

favorite and it will be added to your list of feeds in the Blogline account.

If you are not using one of the more common readers, you will need to tell your
news reader where the RSS feed is on the Internet, it's address. Right-click on the

19 Google Reader <http://reader.google.com>, Bloglines <http://www.bloglines.com>. Google's
iGoogle <http://www.google.com/ig?hl=en>, MyYahoo! <http://my.yahoo.com>, NetVibes
<http://www.netvibes.com>.
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m button or link and select "Copy Shortcut". Then paste this shortcut into your RSS
reader. During this step if you accidentally left click on the~ symbol and see HTML
coding do not panic. From the screen with the XML code, you can also right click on
the URL address and select "Copy". You will then paste that URL into the area of your
RSS reader that allows you to add RSS content.

Do not be intimidated if this seems complicated. Using RSS is the most efficient
way to track new content on the web and stay current with the sites you like the most.
As RSS becomes more widely offered on sites, more RSS readers will most likely offer
one-step buttons for adding content. Enjoy more control over the information on the
Internet - and a reduction in your inbox - as you begin to use RSS.

Online Collaboration
There are multitudes of ways to communicate today and e-mail may no longer

be the tool of choice when the options are weighed. 20 Passing e-mails laden with
attachments bearing the 16th version of a draft contract is no longer efficient or
practical. It creates both efficiency and practical challenges. You have to be vigilant to
open the right e-mail with the right attachment to ensure you're working on the latest
version. You are eating up more computer storage with each additional version. You
are generating a large amount of content that is part of the client's electronic file, and
needs to be organized so that it can be incorporated into that file and preserved or
destroyed, as your retention policy requires.

There are many ways to explore the use of Web communication and
collaboration tools to simplify your e-mail inbox management. Online conferencing
offers document and desktop sharing in real time, and include options like Webex,
Adobe Connect and GotoMeetingY These Web-based tools can help reduce the cost of
travel and simplify collaboration. Some Web conferencing sites offer video in addition to
desktop sharing, to mimic an in-person meeting. Other Web-based collaboration tools
rely on using a shared space, but not necessarily requiring participants to work in real
time.

Asynchronous sites like Zoho or Google's Applications enhance collaboration by
creating shared access to a single document. 22 For example, Google Apps suite offers
online document collaboration, presentations, spreadsheets, e-mail, a project
managementjwiki team space (Google Sites), a customizable start page and more. A

20 The American Bar Association has recently published The Lawyer's Guide to Collaboration Tools
and Technologies: Smart Ways to Work Together, March 2008 <http://preview.tinyurl.com/2ogv8m>

21 Cisco's Webex <http://www.webex.com>. Adobe Connect
<http://www.adobe.com/products/acrobatconnectpro/>, Citrix's GotoMeeting
<http://www.gotomeeting.com>

22 Zoho <http://www.zoho.com>; Google Applications Suite
<http://www.google.com/a/help/intljen/business/applications.html>; Basecamp
<http://www.basecamphq.com/index> Microsoft Sharepoint
<http://www.microsoft.com/serviceproviders/directory/wssv3.mspx>
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law firm could use Google Apps as a collaborative space with clients, co-counsel, staff,
and others. These tools allow for rich collaborative environments to communicate and
collaborate - all without e-mail!

E-mail Management

Once you have put some controls on your e-mail flow, to ensure that what gets
to our inbox is information you want, you can start to deal with it. The first thing to do
is decide what philosophy you are going to apply to your inbox. Two common views
are to leave all e-mail in the inbox, until you have dealt with it and then move it to a
suitable folder, or immediately filter it into sub-folders and then deal with it. 23

Whatever you decide to do, it should be a system that is both efficient and takes full
advantage of your e-mail application.

It isn't just a question of getting the incoming messages organized. It also
involves how to get at them later. Lawyers report spending significant time looking for
documents and e-mails that they created previously.24 Find a system of folders and
filters that work for you, and continue to tweak your system as your needs change.

For example, you might start with your inbox as a triage environment, where
nothing gets moved out until it has been handled. Look for ways to make that as
efficient as possible. E-mail applications like Lotus Notes offer a "send and file" option,
so that you can respond to an e-mail and file the original message in one click. Once
you have a handle for the types of e-mail you are receiving, you may set up filtering
rules: place messages from this address, or containing this phrase, in this folder. The
major e-mail programs support this type of filtering, and the appearance of the folder
changes when it contains unread messages.

Be aggressive about getting e-mail out of your inbox. Like your desk, there is
only so much clutter that you can operate with before you lose track of information.
The search tools within the major e-mail programs are powerful, but the nature of e
mail as documents mean that you may not always remember the exact keywords or
phrases that will retrieve the information you are looking for. Using folders and rules
can make the retrieval go much faster.

Color Me Important
Your e-mail application can give you visual clues about your e-mail. Lotus Notes

enables you to apply a color to incoming messages, to differentiate them from other

23 Two lawyers take on these points in In Re Technology: Triage for E-mail Clutter, 86 ABA
Journal 66 (2000). For a more current view and some different philosophies, see the Five Methodologies
to Deal with E-mail Overload at ReadWriteWeb <
http://www.readwriteweb.com/archivesjfive_methodologies_to_dea 1_with_email_overload.php>

24 LexisNexis Workplace Productivity Survey, December 2007, 52.4% of legal professionals
surveyed reported spending 1 hour or more each day searching for documents and e-mails created
preViously (p. 17) < http://preview.tinyurl.com/333ght >
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messages. You might apply a warning color to messages coming from court e-mail
addresses, or a uniform color for all internally generated e-mail, from other staff and
lawyers in your firm. The visual clue can speed up how you deal with particular
messages.

E-mail Security and Attachments25

As you use your e-mail, consider how your use can impact your practice. Your e
mail application may offer an "automatic address completion" feature, so that you can
type in part of a name and the e-mail address will appear. But what happens if your
system selects the wrong address and you send out privileged information? (see
endnote 4 ).

It's not just whether you address e-mailstothe correct person. It is also
important that the e-mails coming in are from the people purported to be the sender.
Phishing is a common problem, where you receive an e-mail that looks like it is from a
legitimate address, but it asks you to provide additional information after clicking on a
Web site link. A recent modification to the normal phishing scheme is known as
whaling, or spear phishing, and involves far more targeted messages. Rather than
sending out a million e-mails looking for relatively generic information, these targeted
messages are going to specific individuals for whom personal information is already
known - and inclusion of which is likely to lower the vigilance of the recipient. 26

Unfortunately! you need to be sure to incorporate a battery of anti-virus and
anti-spyware utilities to capture threatening applications sent to you under the cover of
a legitimate address or topic. Many threat e-mails are easy to identify, either from the
e-mail address or the content of the message.

If you receive an attachment that is in an e-mail that seems questionable, don't
open the attachment. The legal profession is a collegial one, and you can call your
opposing counsel or the court to determine whether what they sent is a legitimate
message. If you're certain without making that call, delete the e-mail immediately.

What if you are sending attachments? Your recipients will probably be checking
for viruses and other problems. You may have additional concerns, though. You may
be sending a document that contains confidential information in it. You will have to
balance the efficiencies of using e-mail and the possible damage if your e-mail's
contents are received and read by someone who shouldn't see them. If you decide to
send confidential information, considering encrypting it.

25 For more on e-mail security, read the free online booklet called Managing the Security and
Privacy of Electronic Data in a Law Office pp. 19-22 <
http://www.practicepro.ca/practice/pdf/ManagingSecurityPrivacy.pdf >

26 Pseudo Subpoenas Flood Firms with E-mail Virus, New Jersey Law Journal, April 22, 2008 <
http://preview.tinyurl.com/57xnrz >; Sample message <
http://www.snopes.com/fraud/phishing/subpoena.asp >
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E-mail encryption continues to lag, not in its strength, but in its ease of use. A
common application for encryption is Pretty Good Privacy (PGP).27 This will be more
complicated than the average lawyer and average client will want to use.

As an alternative, you can use sites that host your attachments in an encrypted
environment. You upload the file using your Web browser and then send your recipient
a link to that file. Hushmail provides free secure e-mail accounts, as well as other
secure data tools. 28 Other secure attachment sites include YouSendIt and
MegaUpload.29

Conclusion

E-mail is an unavoidable part of the practice of law. We can meet our
professional obligations better as we improve our use of e-mail as a client
communication tool and research support. As you consider your own use of e-mail,
look for ways to make it work for you, making your law practice more efficient and
improving your client and peer interactions.

27 Pretty Good Privacy <http://www.pgp.com>.

28 Hushmail <http://www.hushmail.com>.

29 YouSendIt <http://www.yousendit.com>; MegaUpload <http://www.megaupload.com>
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